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File Management 

Create a New File  

• Select File, then New  
• Select Blank Document. Click OK  
• OR click the sheet of paper icon at very left end of standard toolbar.  

Open an Existing File  

• Select File, then Open  
• In the Look in box at top of Open window, press the down arrow key (which opens a 

drop-down menu), then find and select the drive & folder where document is located.  
• NOTE: In the Files of type box, make sure "All Files (*.*)" appears. If not, click the 

downwards arrow to the right of this box. In the drop-down menu that appears, scroll 
up until you find "All Files (*.*)" and select.  

• Find and highlight the file to be opened. Click the Open button.  
• OR click the folder icon which is second from left end of standard toolbar.  

Save a File  

• Select File, then Save.  
• Select the drive & folder from the Save In drop-down box where the file is to be 

saved. In the File Name box type the name of the document. Click Save.  
• OR click the disk icon which is third from the end of the toolbar (on the left).  
• Note: To save current document under a different file name or folder, click Save As 

instead in the directions above.  
• Note: In the Save as type box, make sure "Word Document (*.doc)" is selected.  

Save a File as a Web Page  

• Select Save as Web Page from the File menu.  
• Select the desired location and name for the file. Make sure the Save as type pull-

down menu says Web Page.  
• Click the Save button.  

Save a Formatted Document as a Template  

• Select Save As from the File menu.  
• Type the name of the file in the File name field.  
• Select Document Template (*.dot) from the Save as type pull-down menu.  
• Select the location where you want to save the template.  
• Click the Save button.  

Print a File  

• Select File, then Print.  
• Select the printer name from the drop-down list.  
• Note: To print landscape mode, click the Properties button and, under the Layout 

tab, select landscape instead of portrait.  
• Click OK.  
• OR click the Printer icon which is fourth from the leftmost end of the toolbar (this will 

automatically print the document on whatever printer is set up as default connection; 
also will print document with whatever default properties are).  
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Print Preview  

• Select File, then Print Preview. Screen displays what file will look like when printed.  
• To view multiple pages, click the Multiple Pages icon and highlight the number of 

pages desired in little image that appears.  
• Click Close button on the top toolbar to close the Print Preview screen.  
• OR click the Print Preview icon (which is fifth from the left).  

Set AutoRecover and Automatic File Backup 

Setting the AutoRecover feature is extremely important! This will prevent loss of your editing 
session in case of a power failue or other emergency shut-down. Setting Automatic Backup 
always keeps a backup copy of the next most recent version of your file in case the current 
version becomes corrupt. It is recommended that you make sure both features are turned on 
when working on any computer with Word installed.  

To set AutoRecover & Automatic Backup:  

• Select File in the Menu bar, then Save As.  
• In the Save As dialog box that opens, select Tools, and in the drop-down menu that 

appears, select Save Options.  
• On the next screen that appears be sure the following features are checkmarked:  

o Always create backup copy  
o Allow background saves  
o Save AutoRecover info every ___minutes (recommended: 5 min. This causes 

Word to save your file every 5 minutes as you write it).  
• Click OK.  

  To recover your document after a power failure or other shut-down:  

• Re-start your computer and get back into Word. Your document that was open at the 
time of a power failue will appear for you. Only changes that you made in the past 5 
minutes will be lost.  

• Check the file to see if any information has been lost.  
• Select File in the Menu bar, then Save As.  
• In the File Name box at bottom of screen, type the file name of the current document 

you were working on at the time of the power failure.  
• Click the Save button.  
• A message will appear asking whether you want to save the current document. Click 

Yes!. This will save your most recent editing (within 5 minutes of the shut-down).  
• Exit the document on the screen and get out of Word.  
• Re-start Word, find your document's file name and open the file to continue working 

on it. This file will contain all your most recent editing intact.  

To replace a damaged file with its backup copy: 

Sometimes files become damaged or are blank when you open them. This is when a backup 
copy of the file is needed.  

• Select File from the Menu bar, then Open.  
• In the Files of type box make sure All Files is selected.  
• In the folder list, find the folder that contains the file that is blank or damaged.  
• Under the Views icon, select Details. (5th button to right of the Look In box at top of 

window)  
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• In the Name column, the backup copy name appears as Backup of document name. 
In the Type column, the file type for the backup copy appears as Microsoft Word 
Backup Document.  

• Find the backup copy of your corrupt document and double-click its file name.  
• When the files opens, save it with the file name of your corrupt document 

(filename.doc). It will overwrite the corrupt document with the backup version so that 
you can continue with your editing.  

File Navigation:  

• Go to beginning of document: Press Contrl + Home (on middle keypad) together.  
• Go to end of document: Press Contrl + End (on middle keypad) together.  
• Go to next page: Press Ctrl + PgDn (on middle keypad) together.  
• Go to previous page: Press Ctrl + PgUp (on middle keypad) together.  

File Editing: Delete, Select, & Copy/Paste: 

   

Delete  

• Delete a character at a time with the Backspace or Delete keys. Backspace deletes 
the character on the left of cursor; Delete deletes the character on the right.  

• To delete a block of text: Select (highlight) the text to be deleted. Press Backspace 
key.  

• To undo a deletion, select Edit, then Undo.  

Select Text  

• To select (highlight) a block of text: Click the mouse at beginning and drag to the 
end of text you want to select. The text will be highlighted in black. The next editing or 
formatting command you execute will affect only that text.  

• To select the entire document: Place cursor at beginning of document. Hold down 
the Shift key while pressing Contrl + End together. You can then apply any text 
properties (in the following sections) to the entire document.  

Copy or Cut (Move) & Paste  

1. First select the text you want to copy or move.  
2. To copy selected text: Select Edit from Menu bar, then Copy (or press Ctrl+C). This 

makes a copy in the temporary Clipboard file and leaves the original as is. 
To cut (move) selected text: Select Edit from Menu bar, then Cut (or press Ctrl+X). 
This moves the text to the temporary Clipboard file and removes the original.  

3. After you use the cut or copy command, use paste to place the text from the 
Clipboard in another location: 
Select Edit from Menu bar, then Paste (or press Ctrl+V)  

Searching: 

  Word Search  

• Select Edit from the Menu bar, then Find.  
• Type the word or phrase you are looking for in the Find What text box.  
• Click Find Next.  
• The cursor will move to the first occurrence of that word or phrase.  
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• Click the Find Next button again to search for the next occurrence.  

Customize Word Search  

• Before clicking the Find Next button (as in above instructions), click the More button 
for more options for your word search.  

• Options include: Match case, Find whole words only, Use wildcards, Sounds like, 
and Find all word forms.  

• Now click Find Next.  

Replace Word  

• Select Edit from the Menu bar, then Replace.  
• Type the word or phrase to be replaced in the Find What text box.  
• Type the word or phrase that will replace the original word in the Replace With text 

box.  
• Click the Find Next button to go to the first occurrence of the word to be replaced.  
• Click Replace if you choose to replace the original with the new word.  
• Click Find Next for the next occurrence of the word to be replaced.  
• Note: You can click Replace All to replace all occurrences of the original with the 

new word all at once.  

Formatting Features: 

  Formatting Toolbar 

• This is a quick method of changing many text properties:  
• If the Formatting toolbar is not shown, select View, then Toolbars on the Menu bar. 

Select Formatting, which will then appear with a checkmark to its left.  
• Select (highlight) the text whose properties you wish to change. 

Note: To highlight the entire document, hold down the Shift key while pressing Ctrl + 
End (on middle keypad) together.  

• Click one of the following buttons as desired: 
Font, Font Size 
Bold, Italics, Underline 
Align Left, Align Center, Align Right, Justify 
Numbering, Bullets  

Using Document Themes 

Themes provide predefined settings for background colors and graphics, body and heading 
styles, bullets, horizontal lines, hyperlink colors, and table border colors.  

• Select Theme from the Format menu.  
• Check the boxes for Vivid Colors, Active Graphics, and Background Image to 

display brighter colors, show animations and display the background graphic.  
• Click the OK button.  

NOTE: Animations will only display when the page is viewed in a Web browser.  

Font Properties (alternate method)  

• Select (highlight) the text whose font you wish to change.  
To highlight entire document, hold down Shift while pressing Ctrl + End (on middle 
keypad) together.  
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• Select Format, then Font.  
• In the Font window you can change the Font, Style, and Size. Click OK.  
• To make this selection your default font, click the Default button. Click Yes in the 

pop-up window.  

Footnotes & Endnotes 

  Note: Do not switch between Word 2000 to Word 97 when typing a paper with 
footnotes because it scrambles them in the conversion process. Stick with one version 
throughout your writing of the paper.  

• Place the cursor in the body of the text where you'd like the footnote symbol to 
appear.  

• Select Insert from the Menu bar, the Reference, then Footnote.  
• Select the numbering style. Click OK.  
• Type the footnote in the footnote section that appears at the bottom of the page.  
• Click anywhere in the document to return to regular typing.  

Header & Footer  

• Select View from the Menu bar, then Header & Footer.  
• To insert header: Type text of header into the header field (dotted box at top of 

screen).  
• To insert footer: Scroll down to bottom of page and type text in the footer field, or 

click the 4th button from right on the Header/Footer toolbar on the screen.  
• Page numbering, date, and other information can be added easily using the other 

buttons on the toolbar.  
• Click the Close button when finished.  

Hyperlink  

• Select (highlight) the word or phrase in your document to be the link.  
• Click Insert on the Menu bar, then Hyperlink.  
• To link it to the Internet, type in the URL address or the path of a local file to be 

retrieved. (Use the Browse button to find the file). Click OK.  

Lists: Numbered or Bulleted  

• To begin, type the number 1. (for a numbered list) or * (for a bulleted list). Then press 
the Tab key or Spacebar.  

• Type the text of the first element of your list. Press the Enter key. (Word 
automatically adds a number or bullet to the next line).  

• To end a list, press the Backspace key, or press the Enter key twice.  
• To insert a new list element in the middle or end of a list, place cursor at the end of 

the line above where you want to insert a new one. Press the Enter key and a 
number (or bullet) will be added automatically to the next line.  

• To change the style of a bullet or number right-click on a bullet or number and select 
Bullets and Numbering. Choose the style desired and click OK.  

Margins  

• Select File, then Page Setup, then Margins tab.  
• Adjust the Top, Bottom, Left or Right margin settings.  
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• Select (highlight) the part of the document to apply the settings to from the Apply to 
drop-down list. (You can choose either whole document or from this point 
forward). Click OK.  

Page Break  

• Select Insert from the Menu bar, then Break.  
• Choose the Page break option button. Click OK.  

Page Numbering  

• Select Insert from the Menu bar, then Page Numbers.  
• In the Position pull-down box, select whether you want the page number to appear at 

the Top of page (Header) or Bottom of page (Footer).  
• In the Alignment pull-down box, select whether the header or footer should appear at 

the right, left, center, inside or outside of page. (The Preview sections shows the 
placement you select).  

• Select whether or not you want to Show number on the first page.  
• Press the Format button to customize page number format or change number 

sequence. Click OK.  

Page Orientation  

• Select File from the Menu bar, then Page Setup.  
• Choose the Paper Size tab.  
• Select Portrait or Landscape. Click OK.  

Line Spacing  

• Select (highlight) the paragraphs to be affected by the spacing change. 
OR select entire document by holding down Shift key and pressing Ctrl + End (in 
middle keypad) together.  

• Select Format, then Paragraph. Click the Indents & Spacing tab.  
• Select the spacing you wish in the Line Spacing drop-down list. (single, 1.5, double-

space...)  

Special Symbols or Characters  

• Select Insert from the Menu bar, then Symbol.  
• From the window that appears, you can click on any symbol to see an enlargement of 

it.  
• To see groups of other symbols, change the Font selection from the drop-down list to 

something else.  
• When you find the symbol you want, click the Insert button. Close the window.  
• Note: Under the Special Characters tab you will find even more characters or 

symbols.  

Subscripts & Superscripts  

• Select (highlight) the number or character to be subscripted or superscripted.  
• Choose Format on the menu bar, then Font.  
• In the dialog box that appears, in the Effects section, place a checkmark in box to left 

of Subscript or Superscript. Click OK.  
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Table  

• Select Table from the Menu bar, then Insert Table.  
• Select the desired number of rows and columns. Click OK.  
• Type the text you want to appear in the first cell of table.  
• Press the Tab key to move to new cell on right. Press the Arrow keys to move up 

and down through the table. Press Enter key within cell to create a new line for typing 
text.  

• You can adjust column widths by dragging the column boundaries to the right or left 
within the table.  

   

• To add a column within the table:  
o Select the column that will be to the right of where you want to insert the 

column and slide mouse slowly across top border of that column until a small 
black down-arrow appears.  

o Right-click at that point where the down-arrow appears to reveal a pop-up 
menu.  

o Choose Insert Columns.  
• To add a column to the right of the last column in a table:  

o Click just outside the rightmost column. Then select Table from the Menu bar.  
o Choose Select Column.  
o Click Table from the Menu bar again.  
o Select Insert, then Columns to the Left or Columns to the Right. A new 

column will appear at the left or right end of the table.  
• To add a row within the table:  

o Select the row that will be just below the inserted row and click mouse at left 
end of that row (where the white arrow appears).  

o Right-click at the point where a white arrow appears; a pop-up menu will 
appear.  

o Choose Insert Rows.  
• To add a row at the end of a table: Click the last cell of the last row and press Tab.  

Tabs  

• If the Tab Ruler is not visible, select View from the Menu bar, then Ruler.  
• To change tab settings:  

o First select (highlight) the paragraphs to be affected by the new tab settings. 
(Tab settings take effect for only those selected paragraphs). 
OR if you want the settings to affect the entire document by holding down 
Shift key and pressing Ctrl + End (in middle keypad) together.  

o You can slide any existing tab markers to new locations by clicking and 
dragging them with the mouse.  

o To place a new tab marker on the Tab Ruler, click in the Tab Ruler (in the 
white space under the tic marks). The tab marker will appear where you 
clicked the mouse.  

• To clear all tab settings for the paragraph before you set new ones:  
o Select the paragraphs you want to affect.  
o Click on Format, then Tabs. In the Tabs screen press the Clear All button 

and click OK.  
• To change type of tab alignment:  

o The Tab Stop Alignment Button (at left end of ruler) is set by default to left-
aligned tabs.  

o To change type of tab, click that button until the desired tab alignment button 
is displayed (Left, Right, Center or Decimal).  

o Note: By moving mouse over the top boundary of this button, you can see 
which tab alignment is represented.  
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Images: 

Insert an Image File  

• Select Insert from the Menu bar, then Picture.  
• From the pop-up menu select From File. (You can insert a .jpg, gif, tif or other image 

file).  

Delete an Image  

• Click the mouse button once on the image to select it.  
• Press the Delete key.  

Move an Image  

• Click the image and hold down the mouse button.  
• Drag the image to the desired location.  
• Release the mouse button.  

Re-size an Image 

• Click once on the image to select it.  
• Run the mouse button over one of the eight handles(little squares) of the image until 

the cursor turns into a diagonal double-ended arrow.  
• Click and hold the mouse button down, and drag the mouse left or right to decrease 

or increase the image size.  
• Once the desired size is shown by the dotted lines, release the mouse button.  

Wrap Text Around an Image  

• Right-click on the image and select Format Picture.  
• Under the Layout tab, from the choice of styles displayed, select one and click OK. 

Text will automatically wrap around the image.    

Screen Views: 

To switch between the following views, click the appropriate button in the bottom left corner of 
the window or select the desired view from the View menu.  

• Normal View: Shows simple text formatting & layout without images.  
• Print Layout View: Shows orientation of embedded images on page when printed.  
• Web Layout View: Document headings display in left frame. When headings are 

clicked, they move cursor to corresponding section of document  
• Outline View: Shows structure of document in left frame, such as heading indents. 

When headings are clicked, they move cursor to corresponding section of document  
• View multiple documents on screen:  

o Open each document with the File | Open command.  
o Select Window from the Menu bar, then Arrange All.  
o Re-size the windows as desired by dragging the boundaries to decrease or 

increase sizes of individual document windows.  
o Click anywhere in a window to make it the active window (will display a 

darker title bar).  
o To view only one document on screen, double-click on title bar of document 

you want to work in.  
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Spelling & Grammar: 

Spellcheck 

Note: Word checks spelling as you type, notifying the user of any misspelled words by 
underlining the word with a wavy red line.  

• To check a word that was red-underlined as misspelled, right-click on the word.  
• Any possible correct spellings will be listed.  
• To replace the word with one of these choices, simply click on the new spelling, and it 

will replace the original word.  
• The word may be underlined because it is not in the Word dictionary. 

To add a word to the dictionary, right-click on the word and select Add from the menu.  
• If you know the word is correct and want the spellchecker to ignore it for the 

remainder of the document, click Ignore All.  

Grammar-check 

Note: Word has a grammar-check feature to automatically check your grammar as you type, 
notifying the you of possibly incorrect grammar in a sentence with a wavy green line.  

• To view the problem, right-click on the green-underlined section.  
• To accept the grammar suggestion, click on the suggested solution, and the new 

phrase will be substituted for the incorrect one.  
• To ignore individual grammar suggestions, select Ignore Sentence.  
• To hide spelling or grammar-check features:  

o Right-click on the book icon at the bottom of the Word window.  
o Select Hide Spelling Errors to turn off spellcheck feature.  
o Select Hide Grammar Errors to turn off grammar-check feature.  

 


